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President’s Message 
Luke Fulp, Kodiak 

 
Each summer the executive board convenes to 
work on strategic initiatives while also dedicating 
time to plan for the upcoming annual 
conference. This summer, the executive board, 
along with any other interested ALASBO 
members, will be meeting for our Summer 
Leadership Conference July 22-24 in Fairbanks. 
 
We’ll begin the event with a day of leadership 
training, facilitated by Illinois ASBO Executive 
Director, Mike Jacoby. This portion of 
Leadership will be focused on team building and 
change management. Given the fact that many 
of us are entrenched in software conversions, 
implementing new policies or introducing p-
cards to our schools, I anticipate this training will 
be relevant to all participants. 
  
Our leadership training will be followed by 
planning for the 2011 ALASBO Annual 
Conference. We’ll discuss which sessions will 
benefit our membership the most, and will 
formulate a draft agenda for the event.  
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It’s amazing how much is accomplished in just 
two days at Summer Leadership. Over the past 
few years, we’ve tried to dedicate some time for 
a fun event like deep sea fishing in Kodiak or 
bear viewing in Wrangell. For our Fairbanks 
visit, we’ve lined up an afternoon trip to Chena 
Hot Springs!  
 
There are still three $500 Swarner Scholarships 
available to support the cost of travel for 
interested members. Thanks to our sponsors, 
most meals and lodging in Fairbanks are 
provided at no cost to participants, so it’s very 
affordable to attend.  Don’t miss out on this 
worthwhile event, and come join us for Summer 
Leadership in Fairbanks. I hope to see you 
there! 

 
Executive Director’s 

Message 
Amy Lujan, ALASBO Executive Director 

 
Well, the legislators have FINALLY left town...! 
 
It was a disappointing year in that we were 
unable to gain traction for a multi-year funding 
plan for the Base Student Allocation (BSA), like 
the one we had for FY09-FY11.  However, the 
legislators did approve a new funding 
mechanism for vocational education (SB84) and 
one-time funding of $20 million each for school 
districts and municipalities (HB108).  A generous 
capital budget was passed at the last minute, 
including funding for the governor’s performance 
scholarships.  All these bills are still pending the 
Governor’s signature.  Additional summary 
information regarding this session’s activity will 
be coming soon. 
 
At this time, I want to encourage you to consider 
registering for ALASBO’s Summer Leadership 
Conference in Fairbanks.  As reference by Luke 
Fulp above, we look forward to outstanding 
training in leadership by Mike Jacoby, as well as 
planning for our annual conference and FUN at 
Chena Hot Springs! There is NO fee to register,  
and most meals and lodging in Fairbanks are 
provided, thanks to our sponsors.  You can 
access registration from our website, 
www.alasbo.org under events-conferences-
upcoming, 

 
If you are a first-time attendee, please apply for 
a Swarner Shaping the Future grant.  The 
application is due June 10 and is available on 
our website, www.alasbo.org under 
opportunites-grants.  There will be THREE $500 
awards this year, to cover airfare and incidental 
costs. 
 
It’s also time to start thinking about attending the 
ASBO International Conference in Seattle, 
September 16-19!  Registration is already open 
on the www.asbointl.org website and can also 
be accessed from our site.  We’d love to see a 
large turnout of Alaskans, since the conference 
is close to home this year!  We’re planning some 
fun events, including a box at a Seattle Mariners 
game sponsored by American Fidelity. 
 
If you have been in school business in a 
supervisory position for less than five years, 
consider applying for a Bridges to the Future 
grant to attend the ASBO International 
Conference.  There will be twenty $2,000 
awards, sponsored by Met Life.  The application 
is available on the ASBO website (above) and is 
due June 1. 
 
In other business, the Board has approved a 
change in ALASBO’s fiscal year to April 1 – 
March 31, starting with the period beginning 
April 1, 2012.  This change reflects our business 
cycle, with the conference having been changed 
to December in recent years.  The Board has 
also approved a plan to support a candidate for 
ASBO Board of Directors; see box  below. 
 
Wishing you all a great start to the summer!  If 
you have questions about any ALASBO 
program, please do not hesitate to contact me at 
alasbo@gci.net, or 907-500-9086.  You’ll also 
find useful information at: www.alasbo.org. 
 
 

 
 

 
 
 
 
 
 
 
 
 

ALASBO to Support ASBO International 
Board of Directors Candidate 

 
The ALASBO Board recently approved a plan to 
support an ALASBO member to run for the ASBO 
Board of Directors in 2012 or 2013!  This will be a 
fantastic professional development opportunity for 
the candidate, and will also draw ALASBO members 
into a shared project to increase participation in 
ALASBO and ASBO. 
 
Tom Freeman of Anchorage served as an ASBO 
Director in the early 80’s and Melody Douglas of 
Kenai was a Director and later President of ASBO in 
2001-2007.  Applications to be our next ALASBO 
candidate will be available soon! 
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Make your Next School 
Board Presentation a 

Winner 
David Levin, author of “Don’t Just Talk, Be 

Heard!” 
 
Does this sound familiar? You’re standing before 
your school board, about to make a 
presentation. You have bad news to share and 
you know they don’t want to hear it. As you 
stand there, your heart is pounding, your mouth 
is dry (unlike your underarms)—and you haven’t 
even started yet!  
 
Don’t feel bad. You’re not alone. Presentations 
in general give lots of people fits. But school 
board presentations can be especially 
challenging. For one thing, no two boards—or 
board members, for that matter—are alike. 
Everyone will have their own expectations, 
interests, even agendas, which can get very 
complicated to sort out. My suggestion is, rather 
than driving yourself crazy trying to shape your 
message for each board member individually, 
speak in a way that works with all of them, no 
matter their differences. Here’s how. 
 
Don’t tell them stuff. Connect with them. First, 
always keep in mind that the most important part 
of your presentation is not the information you’re 
sharing, but HOW you’re sharing it. That’s hard 
to remember when you’re in the hot seat, but it’s 
true, and very important. The worst thing you 
can do is get up there, bury your face in your 
notes and start reading. For one thing, it’s 
boring. “Blah blah blah.” More important, it 
comes off as weak and lacking in confidence, 
which are exactly the wrong impressions to give. 
  
More than anything else, board members need 
to feel that you’re someone they can count on 
and trust, that you know what you’re doing, and 
understand their needs. The more they think that 
of you, the more likely they are to hear what you 
have to say. So, rather than reading from your 
notes, just talk to them. Stand up straight. Look 
them in the eye. Smile. Speak up. Speak clearly.  
  
You want to come off as confident, open, 
relaxed, and trustworthy as possible. Anything 
that supports those impressions helps you. 
Anything that undercuts them hurts. Reading 
from a prepared statement definitely hurts.  
 
NOT Just the Facts 
Style is one thing. What about substance? How 
should you share the information itself? First, it’s 
a given that it has to be shared completely, no 

matter what. You would obviously never want to 
change the facts of a presentation to please an 
audience. But the words you use to share those 
facts can definitely change how they are 
received. Consider these two examples: 
 
A) “The numbers are ___.” 
 
B) “This next number is one I’m afraid you’re 

not going to be happy about. The truth is, 
I’m not happy about it either. I know this is 
something you feel strongly about and that 
it’s frustrating for you. I apologize for that, 
and understand that it’s our responsibility to 
get the job done. Honestly, we are 
disappointed with the numbers too. All I can 
say is that we’ve been working hard on it, it 
has our full attention, and we are making 
some progress, though not as much as any 
of us would like.” 

 
The main objective with all your communication 
is to keep people from dismissing you or filtering 
your words so that they really hear what you’re 
saying. I think it’s clear that the second 
approach does just that. The board may not like 
the information, but it’s pretty hard for them to 
just write you off and go into reactionary mode 
when you’ve demonstrated such humility, 
candor, empathy, and accountability.  
 
The point here is not to somehow make the 
news better, or even make board members like 
it better. The point is to keep the bad news from 
damaging the relationship, because the quality 
of the relationship is the most important factor in 
your success, long-term. Done well, sharing bad 
news not only doesn’t have to harm the 
relationship, it can actually make it stronger.  
 
Planning, Feedback, and Practice 
Finally, I can’t emphasize enough the 
importance of planning, feedback, and practice. 
First, plan out exactly what you want to say, 
taking into account all we’ve talked about with 
connection and the relationship. Then, run your 
plan by someone for feedback. This is a critical 
step that too many people overlook. I can’t tell 
you how many times I’ve seen someone say 
exactly what they intended—without realizing 
what a bad idea it was in the first place! Before 
you go out and plant your foot in your mouth, get 
feedback! Find someone who: 1) Knows what to 
look for; 2) Will tell you truth; 3) Ideally, can 
suggest other things to say, if necessary.  
 
Finally, practice. Practice brings confidence and 
helps you connect. It also sends powerful 
 

(Continued on page 4) 
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messages of respect, especially when you 
consider the impressions of not being practiced 
and ready. When you show up not knowing your 
stuff, winging it, acting nervous and not ready to 
answer questions, at best it says you’re 
incompetent. At worst, that you don’t care. You 
simply must practice your presentation. And I 
don’t mean just running through your 
presentation once the day before. I mean run 
through it a LOT. If you have opening and 
closing comments, memorize them. Practice 
them out loud, and standing. If you have 
materials, practice with them too. Make it as 
much like the actual presentation as possible, 
and you should practice the whole presentation 
until you are comfortable with all of it and have 
the opening and closing memorized. 
 
There are plenty of other things to say about 
effective presentations, too. But if you take these 
few suggestions to heart you’ll go a long ways to 
making your next board presentation the best 
one yet! 
 
David Levin is the author of “Don’t Just Talk, Be 
Heard!” and the co-author of three books, 
including the bestselling” QBQ! The Question 
Behind the Question”. His keynotes and training 
tools help people communicate better, so they 
can live their full potential—at work and at home. 
Please visit www.JustBeHeard.com for 
information. 
 

 

ALASBO 

 
 

Member Spotlight  
Yodean Armour, Klawock City Schools 

 
Tell us about your school district 
Klawock City School District is a single site 
district in Klawock, located on Prince of Wales 
Island (Southeast Alaska).  We serve 130 
students in grades K-12, and have 20 certified 
staff and 19 classified staff. 
  
How long have you been in school 
business? 
This is my 6th year as Business Manager. 
  
How did you get into this business? 
My first year in Klawock Schools I worked as the 
Activities Director, and a year later was hired as 
the Business Manager. 
  
What do you like best about your job? 
Being part of a great team and working 
alongside some of my past teachers (I am STILL 
learning from them). 
  
What advice do you have for those new to 
school business? 
Be sure to attend the Annual Conference in 
December, and don't hesitate to email/call a 
fellow ALASBO member for assistance. 
 
How have you benefited from membership in 
ALASBO? 
The networking opportunities, power lunches, 
and various updates have all been incredibly 
helpful. 
 
What do you like to do for fun? 
When I have time, I love being out on the water. 
  
If you could visit anyplace in the world, 
where would you go and why? 
New Zealand – to experience beautiful scenery 
and the Maori culture. 
 

(Continued on page 5) 
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Tell us something about yourself that most 
people don’t know? 
From Head Start to High school, I just knew I 
was going to be a doctor....but dropped that idea 
when I discovered the requirement for the 
college anatomy class (cadaver?!). 
  
What is your proudest accomplishment? 
 

Moving back to Klawock and giving back to the 
community that held me up while I was at  
school. 
 

 
 

Awards Committee 
Announcements 

Cindy Reilly, Yukon-Koyukuk School District 
 

The Awards Committee has been busy since our 
annual conference giving out money!  Each 
year, we read applications for three 
scholarships:  the Lowell Thomas Freeman 
Grant to send a member to the annual 
international conference; the McClain “Mack” 
Easton Memorial Scholarship for deserving 
high school seniors; and the Richard Swarner 
Shaping the Future Grant to send first-time 
attendees to the Summer Leadership 
Conference.  

This year, we had five members apply for the 
$1,500 LT Freeman Scholarship.  The winner is 
Carl Horn, Director of Finance at Nenana City 
Public Schools.  All five applicants were very 
deserving, but what the committee determined 
was that Carl had been a member of ALASBO 
for several years but never had the opportunity 
to go to the annual conference, which this year 
is in Seattle, September 16-19.  Thanks to 
CORE, Inc. for their multi-year sponsorship of 
this grant program. 

Forty-six seniors from across the state applied 
for the Mack Easton Memorial Scholarship.  The 
committee agreed they were all MORE than 

deserving…very top-notch young adults.  The 
winners are: 

• Sonja Jones, Kodiak Island Borough 
School District 

• Leanna Rice, Wrangell Public Schools 

• Kelley Sefton, Seward High School 
(Kenai Peninsula Borough School 
District).  

We were able to award three scholarships of 
$1,000 this year, one more than in previous 
years, thanks to the sponsorship of Alaska 
Communications Systems, Alaska Education 
and Recreational Products, LLC and GCI 
SchoolAccess. 

The final grant opportunity of the year is now 
open for applications through June 10.  If you 
would be a first-time attendee to ALASBO 
Summer Leadership, we would love to have you 
apply for one of the $500 Swarner grants to 
attend.  Since lodging in Fairbanks for the July 
22-24 event and most meals are covered by our 
event sponsorships, the $500 will in most cases 
cover airfare and incidentals, making it very 
affordable to attend and participate in this 
excellent professional development opportunity.   
 
This year, THREE grant awards will be 
available, thanks to the Swarner family and 
National Cooperative RX.  The application is 
available on the ALASBO website, 
www.alasbo.org, in the opportunities-grants 
section. 

 
 
 
 
 
 
 
 
 
 
 
 
 

Call for Presentations 
 

What do your colleagues need to learn about at the 
annual conference in December?  What can you 
contribute? 
 
ALASBO is currently seeking presentation proposals 
for the December 4-7, 2011 Annual Conference.  The 
networking and information sharing among our 
members and associates is what makes the ALASBO 
conference so valuable to Alaska school business 
staff each year. 
 
Please consider submitting a presentation proposal 
for this year’s conference.  We need ideas for 
sectionals, cracker barrels (less formal, more Q&A) 
and roundtables.  Present a project you’ve been 
working on, or perhaps a panel discussion with 
several colleagues.  We need your input! 
 
The proposal form is available on the ALASBO 
website, www.alasbo.org under events-conferences-
upcoming, and it’s due July 15. 
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Website Updates 
 
If you have a question or are looking for 
something, www.alasbo.org is a good place to 
start for updated information!  Here are some of 
the recent updates and where to find them: 
 
• Registration links for members and vendors, 

for upcoming events: events-conferences 
• Call for Presentations form for annual 

conference: events-conferences-upcoming 
• Power Lunch schedule for 2011 and materials 

from recent Power Lunches:  events-
workshops 

• Updated Board Job Descriptions: about 
ALASBO-policies & procedures 

• Updated Policy Manual: about ALASBO-
policies & procedures 

• Current grant and scholarship applications: 
opportunities tab 

• Presentation materials from 2010 Annual 
Conference: resources-downloads tab 

• Membership form for anyone in your district 
who is not yet a member (it’s just $75!):  
membership tab 

 
Let me or anyone on the Services Committee 
know your suggestions for making the website 
more useful! 

 
ALASBO 

2011 Liaison Assignments 
 
Past-President – Laura Hylton --- Lake & 
Peninsula  246-4280    lhylton@lpsd.com 
 

Robbie MacManus  
Alaska Gateway Schools 
883-5151x109  rmacmanus@agsd.us 

 

Chelsea Sternicki 
Aleutian Region Schools 
277-2648  csternicki@aleutregion.org 

 

Carl Warner 
Aleutians East Borough Schools 
383-5222   cwarner@aebsd.org 

 

Chad Stiteler 
Anchorage School District 
742-4369   stiteler_chad@asdk12.org  
 
Charlene Jimenez 
Annette Island Schools 
886-6011   cjimenez@aisd.k12.ak.us 

 

Mark Vink 
Bering Strait Schools 
624-4256   mvink@bssd.org 

 
 
Secretary --  Laurie Olson  --- Kenai  
714-8888   laurie@kpbsd.k12.ak.us 
 

Sherry Kern 
Bristol Bay Borough Schools 
246-4225   skern@nnk.gcisa.net  
 

Teri Dierick 
Chatham Schools 
586-6806   terid@serrc.org 
 
Adrienne Fleming 
Chugach Schools  522-7400   
afleming@chugachschools.com 
 
Loreen Kramer 
Copper River Schools 
822-3234 x225 lkramer@crsd.k12.ak.us  
 
Verna Reedy 
Cordova City Schools 
424-3265   vreedy@cordovasd.org 
 

Karen Head 
Craig City Schools 
826-3274   khead@craigschools.com 
 
 

 

Director Seat A – Lee Ann Andrew --- Southwest 
Region  842-8207   landrew@swrsd.org 
 

Kim Johnson    
Delta/Greely Schools 
895-4657   kjohnson@dgsd.k12.ak.us 
 

Nancy Hollis 
Denali Borough Schools 
683-2278   nhollis@dbsd.org 

 
Lucienne Smith 
Dillingham City Schools 
677-9263   lucienne.smith@akebs.com 
 

Mike Fisher 
Fairbanks North Star Borough Schools 
452-2000 x301 michael.fisher@k12northstar.org 
 

Christine Johnson 
Galena City Schools 
656-1205   chrisj@galenanet.com 

 

Judy Erekson 
Haines Borough Schools 
766-6725   jerekson@hbsd.net 

 
Judy Hankla 
Hoonah City Schools 
945-3611   hanklaj@hoonahschools.org 

 
(Continued on page 7) 
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Director Seat B – David Arp ---Sitka 
966-1254   arpd@mail.ssd.k12.ak.us 
 

Tammy Stromberg 
Hydaburg City Schools 
285-3591   auroracorp@hotmail.com 
 

Isabelle Harrington 
Iditarod Area Schools 
524-3599 x224   iharrington@iditarodsd.org 
 

David Means 
Juneau Borough Schools 
523-1770   david_means@jsd.k12.ak.us 
 

Teri Dierick 
Kake City Schools 
586-6806   terid@serrc.org 
 

Antonia Moses 
Kashunamiut Schools 
858-7713   amoses@chevakschool.org 
 

Dave Jones 
Kenai Peninsula Borough Schools 
714-8838 djones2@kpbsd.k12.ak.us  

 
Matthew Groves 
Ketchikan Gateway Borough Schools 
247-9013   matthew.groves@kgbsd.org 

 
Director Seat C  --  Leslie O’Connor ---  Yukon Flats 
662-2515   leslie.oconnor@yukonflats.net 
 

Yodean Armour 
Klawock City Schools 
755-2220   yodean.armour@klawockschool.com 
 

Luke Fulp 
Kodiak Island Borough Schools 
481-6105   lfulp01@kodiakschools.org 

 

Martha Morgan 
Kuspuk Schools 
675-4250 x110   mmorgan@kuspuk.org 
 

Laura Hylton 
Lake and Peninsula Borough Schools 
246-4280   lhylton@lpsd.com 
 

Blair Alden 
Lower Kuskokwim Schools 
543-4820   Blair_Alden@lksd.org 

 
Jenny Martens 
Lower Yukon Schools 
591-2411 x220 jmartens@loweryukon.org 
 

Ken Forrest 
Mat-Su Borough Schools 
761-4001   Ken.Forrest@matsuk12.us 
 

 

Director Seat D -- James Farrington --- Anchorage 
465-4344   farrington_james@asdk12.org 
 

Carl Horn 
Nenana City Schools 
832-5400 x230   chorn@nenanalynx.org 
 

Cathi Wojtanek 
Nome Public Schools 
443-6190   cwojtanek@nomeschools.com 
 

Tammy White 
North Slope Borough Schools 
852-9524   tammy.white@nsbsd.org 
 

Karen Goodwin 
Northwest Arctic Borough Schools 
442-3472 x232  kgoodwin@nwarctic.org 
 

Melody Douglas 
Pelican City Schools 
398-6819   douglas.melody@gmail.com 
 

Wendy Einerson 
Petersburg City School District 
772-4271   business@psgsd.k12.ak.us 
 

Earle Trumble 
Pribilof Island Schools 
546-3324  earle_trumble@psd-k12.ak.us 

 
Director Seat E ---  Chad Stiteler --- Anchorage 
742-4369   stiteler_chad@asdk12.org 
 

Davey Shields 
Saint Mary's Schools 
245-0650   davey@acsalaska.net 

 

David Arp 
Sitka Borough Schools 
966-1254   arpd@mail.ssd.k12.ak.us 
 
(Continued on page 8) 
 

(Continued from page 7) 
Cindy O’Daniel 
Skagway City Schools 
983-2960   busmgr@skagwayschool.org 
 

Lucienne Smith 
Southeast Island Schools 
828-8254   smith@sisd.org 
 

Lee Ann Andrew 
Southwest Region Schools 
842-8207   landrew@swrsd.org 
 

Stefani Dalrymple 
Tanana Schools 
479-9863   stefani@yukonac.com 
 

Holly Holman 
Unalaska City Schools 
581-3151 hholman@ucsd.net 

 
(Continued on page 8) 
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Director Seat F  --  Yodean Armour --- Klawock  
755-2220   yodean.armour@klawockschool.com 
 

Amber Cockerham 
Valdez City Schools 
835-4357   amber_cockerham@valdez.cc 
 

Pam Roope 
Wrangell City Schools 
874-2347   proope@wrangellschools.org 
 

Ricardo Tejeda 
Yakutat City Schools 
784-3317 x225   ricardot@yakutatschools.org 
 

Leslie O'Connor 
Yukon Flats Schools 
662-2515   leslie.oconnor@yukonflats.net 
 

Cindy Reilly 
Yukon-Koyukuk Schools 
374-9410   creilly@yksd.com 
 

Michele George 
Yupiit Schools 
825-3603 mgeorge@yupiit.org 
825-3604  

 

Your Moment of EXCEL 
Zen 

You probably use conditional formatting to 
highlight specific values in a conditional way. For 
instance, if a value is less than 0, you might 
want to display that value in red. You can also 
use conditional formatting to highlight a range of 
input cells - it’s simple and the result is an easy-
to-implement data entry guide. 

The following sheet shows a simple savings 
calculator that uses conditional formatting to 
highlight the input cells for each savings option. 
The user selects a savings options from the list 
and conditional formatting highlights the input 
cells. Those cells remain highlighted until the 
user selects a different savings option from the 

list. The formulas above the input area display 
the appropriate savings result. 

 

Before we get started, you should know that this 
example is about using conditional formatting to 
highlight input cells. It is not about the savings 
formulas or the other pieces used to round out 
this example. In fact, you don’t have to enter the 
formulas at all to get this technique to work. 
There are a number of ways to enhance this 
sheet further if your goal is to build a savings 
calculator. For instance, a finished sheet might 
display only the relevant results (column B in the 
upper portion). In addition, I based the data 
validation list on the static list in the upper part of 
the sheet. You might not want to display that list 
in the actual data entry portion. For the sake of 
explanation and simplicity, I chose to put 
everything on the same sheet. 

Now, let’s get started! To build the sheet, do the 
following: 

1. Use the sheet below (which displays 
gridlines) as a guide to entering the labels. 

2. Next, define the following names: 
B6 Rate 
C6 YSave 
D6 MSave 
E6 OTSave 
F6 Deposit 
G6 Goal 

3. Enter the following formulas 
B2 =IFERROR(FV(Rate/12,YSave*12,-
MSave,-Deposit),”Error”) 
B3 =IFERROR(FV(Rate,YSave,0,-
OTSave),”Error”) 
B4 =IFERROR(PMT(Rate/12,YSave*12,-
Deposit,Goal),0) 

At this point, your sheet should resemble the 
one below. You might want to apply the currency 
format to B2:B4 and D6:G6. I also shaded and 
outlined a few label cells. (These formatting 
steps aren’t necessary for the technique to  

(Continued on page 9) 
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work.) Now you’re ready to build the list that 
offers savings options. 

 
  

1. Select A6. 
2. Click the Data tab. 
3. In the Data Tools group, click the Data 

Validation dropdown. 
4. Choose Data Validation. In Excel 2003, 

choose Validation from the Data menu. 
5. In the resulting dialog box, choose List from 

the Allow dropdown. 
6. Enter =$A$2:$A$4 in the source control and 

click OK. 

 

The next step is to add the conditional formatting 
that highlights the input cells for each savings 
option. To do so for the first savings option, 
Future Value (Monthly), do the following: 

1. Select cells B6:D6 and F6. 
2. Click the Home tab. 
3. In the Styles group, click the Conditional 

Formatting dropdown. In Excel 2003, 
choose Conditional Formatting from the 
Format menu. 

4. Choose New Rule. (Skip this step in Excel 
2003.) 

5. Select the Use A Formula To Determine 
Which Cells To Format option in the Select 
A Rule Type section. In Excel 2003, choose 
Formula Is from the Condition 1 dropdown. 

6. In the Format Values Where This Formula Is 
True control, enter the formula: 
=$A6=”Future Value (Monthly)”. 

7. Click Format. 
8. Choose color from the Fill tab and click OK. 
9. Click OK to return to the sheet. 

 
 
Repeat the steps above to set the conditional 
formatting for the other two savings options: 

• Future Value (One-Time) uses input cells 
B6:C6 and E6 and the conditional formula, 
=$A6=”Future Value (One-Time)”. 

• Savings Goal uses input cells B6:C6, F6:G6 
and the conditional formula, =$A6=”Savings 
Goal”. 

If you like, you can turn off the gridlines by 
clicking the Page Layout tab and unchecking the 
View option under Gridlines in the Sheet Options 
group. At this point, your sheet should resemble 
the first sheet shown above, which highlights the 
input cells for the third option, Savings Goal. 

To guide data entry for the first option, Future 
Value (Monthly), choose that option from the 
validation list. As you can see below, doing so 
highlights a different set of input cells. Choose 
Future Value (One-time) to change the input 
cells to accommodate that savings option. 

(Continued on page 10) 
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(Continued from page 9) 

Remember, you can further enhance this sheet as an actual savings calculator. You might want to use 
different (more precise) formulas, or add more savings options and input values. You’d probably want to 
apply validation rules for the input cells and protect the formula and label cells. In addition, you should 
probably delete input values when changing options. They won’t interfere with the formulas if you leave 
them, but they might confuse users. 

The sheet, as is, illustrates how to use conditional formatting to highlight input cells. It doesn’t complete 
the savings calculator as a useable product. 

Mark Your Calendars! 
 

 
Upcoming Events 

 
2011 ALASBO 

  
 

 
• July 22 – 24 - ALASBO Summer Leadership – Fairbanks 
 
• September 16-19 – ASBO International Annual Conference – Seattle  
 
• December 4-7 – ALASBO Annual Conference – Anchorage 
 

 
Power Lunch Teleconference 

 Schedule 

11 AM to noon, the 3rd Tuesday f 
each month 

call 218-844-3377, code 252726  
(spells ALASBO!) 

 

  
  

June 21 RFP Bid Process 

July 19 Business Office  
Inservice 

August 16 Cooperative 
Purchasing 

September 20 TBA 

   October 18 Health Care Reform   
Update 

November 16 1099’s and W-2’s 
November 22 Indirect Cost Form 

December ALASBO 
CONFERENCE  

 


